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Positive Pay Overview

Positive Pay is an advanced fraud detection and prevention service that enables you to take control of
your financial security. Account holders can respond to actionable alerts for suspicious Check and ACH

transactions.
The Positive Pay platform contains the following functionality:

Issued Check Management: Submit issued check files or manually input checks
Check File Maintenance

ACH Rules Management: Approved & Block List

Daily Exception Notifications

User Management: Set up additional users and set customizable permissions

YV V. V V VYV V

Online Portal

System Compatibility
All modules are supported for the following browsers.

Chrome: Last 4 versions
Firefox: Last 4 Versions

Firefox Extended Support Releases: Latest

SSURNEE NN

Edge: Last 4 versions

Service Modules

Check Positive Pay: A service designed to prevent financial loss due to check fraud. It relies on
members to input issued check information, make daily decisions on exception items when required.
When accounts are enrolled, a default setting is established for the system to return or pay a transaction

by the established end-of-day cut-off time. (See page: 11)

ACH Positive Pay: ACH Positive Pay Debits and ACH Positive Pay Credits are two separate services

designed to empower account holders to prevent financial loss due to unauthorized incoming ACH debit

and ACH credit transactions. (See page: 24)

C.0.P.S.: ACH Credit Origination Protections Service (C.O.P.S.) is designed to provide members with
protection against fraudulent ACH credit origination activities. By monitoring the destination of ACH credit
transfers, ACH Credit Origination Protection (C.O.P.S.) can provide an additional layer of security. (See

page: 35)

Rev February 2024
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Access

To launch Positive Pay, log in to your Northwest online banking portal and perform the following steps:

1. Click on Business Administration, then select Positive Pay HQ.

NORTHWEST

FECERAL CRECHT UPECIN

Dashboard Accounts Business Transfor & Pay Business Admanistragicn Toods

Da shhnard Business Administration

BusiressAdmir

BumnessReports “ti
Accounts
Positive Pay HD  ¢—

B _ -

2. Select Submit.

Dashboard Accounts Business Transfer & Pay Business Administration Tools

@

Positive Pay

PositivePay
Positive Pay ACH Alert

- 3

3. The Positive Pay platform has been launched.

Rev February 2024
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Positive Pay Dashboard

Upon launching the Positive Pay platform, the member dashboard is the default landing page. The

member dashboard is where all functions spanning one or more service modules are performed.

Module Summary Box

For each active Positive Pay service module, the Member Dashboard shows a summary box displaying

the following:
» Current day’s transaction information, totals, and counts
» End of day cut-off time is displayed, indicating the deadline for daily decisions on transactions.
Dashboard & Manage Users  # Perform ~ ol Reports - = Transaction View Change Module »~ & Sally DeLaere ~

ACH Credit Origination Protection

Total Credits $0.00 (0]
Exceptions $0.00 (0]

End of Day Cut-Off Time: Wednesday 7:00 PM EST

ACH Positive Pay - Debits

Total ACH Debits $0.00 ©  Pending Approval $0.00 0]
Setto Pay $0.00 (0] Set to Return $0.00 (0]
Approved List Exceptions $0.00 ©  Block List Returns $0.00 [ 0]

End of Day Cut-Off Time: Wednesday 1:00 PM EST

The Member Dashboard supports navigation to a service module by clicking on the service module name

in the blue bar. Users can navigate to transactions with a specific status within a service module by

clicking on the dollar amount link displayed to the right of the status.

Other Dashboard Functionality

>
>

Manage Users
Perform (Transaction Approval)
o Note: This menu option is only applicable to members enrolled in dual approval.
Reports (See page 41)
Transaction View

Change Module

Rev February 2024
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Manage Users

A user with admin user privilege can add additional users and set the appropriate module permissions. To

create additional user:

1. Click on Manage Users from member dashboard. The member user page will appear.
2. Click on the “Create New User” button.
3. Complete the following:

+ SSOID (Users NWFCU Online Banking Username)

*  Note: The maximum number of allowable characters in the
SSO ID field is limited to 50.

* First & Last Name
e Email Address
+ Contact Phone Number

*  Cell Phone Number (Must be entered to receive Test/SMS)

4. Click the “Create User” button.

Cuthbert Allgood

[ Active

Username
9SteaxpUg

First Name Last Name
Cuthbert Aligoed

Email Address Contact Phone Number Cell Phone Number
cuthberta@finefeathers.com (555) 555-5555 (555) 555-5555

5. The User profile page appears. Scroll down to the “System Roles” section of the page to
select what roles should be enabled for the user.

System Roles

[all | none]

£ Audit Report Notification Delivery Consolidated Pending Consolidated
Report Approval View Transaction History View

Rev February 2024
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6. For each service Module, select the appropriate permissions and corresponding accounts.

Check Positive Pay

Available Accounts

Check Positive Pay User Privileges

- Alert Method: | Email, SM5/Text v

Selected Accounts

<

User Privileges <z

[all | none]
[_| Approve Issue File
Transaction History
Cancel Issue Item
Manage Issue File Status
Issue Warehouse

Paid No Issue Matching

ACH Positive Pay - Debit

Available Accounts

Testing LLC (ooe3003) <4

Item Lookup

Change Transaction Status
Edit Issue Item

Issue Templates

Load Issue File

Issue Item Status Report
["] Decision Dual Approval
B view Issue File Status
Issue Load Alerts

Manual Issue Entry

ACH Positive Pay User Privileges - Debit

Selected Accounts

<<

User Privileges =
[all | none]
Act on Approved List
Blocked List
Notification Rules Report

| Blocked List Dual Approval

Testing LLC (oooaooz) <

Act on Blocked List
Change Transaction Status
[ Decision Dual Approval

Transaction History

Approved List
Notification Rules

[C Approved List Dual Approval

Rev February 2024 n

Proprietary and Confidential Information



NWEFCU Positive Pay User Guide

ACH Positive Pay User Privileges - Credit

ACH Positive Pay - Credit

Available Accounts Selected Accounts

Testing LLC {oxx3003) _

<z

User Privileges <4mm

[all | none]
Act on Approved List Act on Blocked List Approved List
Blocked List Change Transaction Status Motification Rules
Motification Rules Report B Transaction History

C.O.P.S. User Privileges

C.O.PS. =) Alert Method: |- None - v

Available Companies Selected Companies

Testing LLC(1234) -

<

User Privileges <=
[all | none]
Approved List Approve Issuance File * Manage Batches?

Remove Payment Recipient

! protectad role

7. Select the “Save User” button.

Rev February 2024
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Alerts

Within the Check Positive Pay or C.O.P.S. settings box, the alert method can be chosen. Use the drop-
down to select the alert method desired.

Note: ACH Positive Pay Alerts are customizable and managed through the service module. (See
Page:25)

Check Positive Pay Alert Method: |- None v
[-None- ]
Email
Available Accounts Selected Accounts Email, SMS/Text

SMS/Te

Email Client User will receive Check Positive Pay (PRO-CHEX) Alerts via Email only

Email. SMS/Text C.';Iierlf User will receive Check Positive Pay (PRO-CHEX) Alerts via Email and

SMS/ | ext
SMS/Text g}:;m User will receive Check Positive Pay (PRO-CHEX) Alerts via SMS/Text

Transaction View

While transaction views are available within each service module, the transaction view from the
Member Dashboard consolidates transactions for ACH Positive Pay and Check Positive Pay
allowing users to make pay/no pay decisions from a single screen.
» Transactions are stored and visible for one (1) year
» The Consolidated Transaction History user privileges must be enabled to access this screen.
» If the user has been granted the Change Status user privilege and the transaction is available to
decision, the Pay and Return button are available to use.
» Transactions to be paid have green shading and to be returned have yellow shading in the
background.

1. From the Member Dashboard, click Transaction View.

2. The Transaction History page appears. Transaction View will display all the current day’s

transactions for ACH Positive Pay and Check Positive Pay by default. To filter the date range,

click on the Date Range drop-down, select the desired date range, and click the Apply button.

Rev February 2024 n
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Date Range
Transaction History & ul 27, 2023~
Check Mass Pay & Issue Payee Review (0)
Y Filters >
Type Description Account Date Credit Debit Current Status Manage Exception/Violation

» ACHCredit  new day xo3333 727423 100.00 Return - System Q

3 ACHCredit  newday 0003333 7427/23 100.00 Return - System Q

3 ACHCredit  HeartBreak XOXG555 742723 75.00 Return - System =

> ACHCradit  HeartBreak X4XX5555  7/27/23 50.00 Approved List Pay

> ACH Credit Niveena's Natura 00003333 7123423 100.00 Return - System B

3. The following information will be displayed for review:
» Type: Provides the type of transaction displayed.
> Description: The type of account or the check number depending on the transaction type.
» Account: Account number associated with that transaction.

» Date: Date of the transaction.
» Credit/Debit: Amount of the associated credit or debit appears under the Credit or Debit

columns.

Y

Current Status: Status the transaction is currently in, either Paid or Returned.

» Manage: Displays a Pay or Return button. This allows for decisioning directly from the
consolidated transaction view if End of Day (EOD) has not passed for a specific service.

» Exception/Violation: Various Icons inform the user of the item exception(s). Hovering over

the icon gives the user a quick glance at the Exception Reason. (See Page 42)

4. If the search contains more than 25 transactions, the results are displayed on multiple pages.
Use navigation buttons at the top of the search results to review all results.

Rev February 2024 n
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Change Module

Users can navigate to other service modules if granted access to those modules. Users can change
modules by selecting the Change Module drop-down and clicking on the service module or by

clicking the service module name listed in the blue bar in the Member Dashboard.

There are two methods to change between available modules.

1. From the Member Dashboard, click Change Module > desired module.

mNORTHWEST

FEDERAL CREDIT UNION

Dashboard A& ManageUsers  # Perform =  JiReports ~ Change Module » &

C.OPS.

ACH Positive Pay - Credit ACH Postive Pay - Credit
ACH Positive Pay - Debit
End of Day Cut-Off Time: Thursday 2:30 PM EST Check:Posivelkay,
1

2. From the Member Dashboard, click the desired service module name on the appropriate
blue bar in the Member Dashboard.

Rev February 2024
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Check Positive Pay

Check Positive Pay is a service designed to prevent financial loss due to check fraud. The table below
lists the Positive Pay types available for each account enrolled, along with a description of expected

behavior.

Check Positive Pay relies on members to make daily decisions, when required, for the check activity
occurring on their accounts. When accounts are enrolled, a default setting is established for the system

to return or pay a transaction by the established end-of-day cut-off time.

Type Service Description

Standard | This service requires the Member to provide a list of checks issued or voided on an account
Positive (Issue Items). The issue items for each account must include, at a minimum, a check serial
number, amount, and status (Issued, Voided, Stopped). The FI compares each check

Pay presented for payment (Iltem) against the list of issue items. If an exception is identified,
designated users are alerted to make a pay or return decision.
Payee Members are required to provide the payee name for each issue item. The solution
Positive compares the name in the issue item against the name on the “Pay to the Order of” line of
p the check presented for payment. A scoring method is used to determine the likelihood of a
ay

match, and if the score falls below the established threshold, the item is flagged as an
exception. Payee name scoring is subject to many variables, including image quality.
Scoring may fail items that would otherwise pass if members fail to perform and conform to
best practices

Reverse This service does NOT require members to provide a list of issued items. Members should
log in every day to view checks presented for payment and select the checks to return
because the concept of an exception does not exist, since no list of issue items is present
to compare items against. However, members may request the Fl establish a maximum
check amount per account (Exception Limit). If this optional setting is enabled, an alert is
sent to designated users ONLY when a check is presented exceeding the maximum
amount established.

Positive

Pay

» Alerting: Check Positive Pay notifies designated users to take action when required.

» lIssue Items: A status defined by the member that indicates a check was issued.

» Exception Item: When a check cannot process and clear a check normally, the payment
becomes an exception item requiring special handling. If Payee Positive Pay is enabled, the
check image is scored through payee name comparison. Examples of reasons a check can
be flagged as an exception include but are not limited to: Payee Mismatch, Amount Mismatch,

Voided or Stopped Status, and Early Presentment.

Rev February 2024
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Check Positive Pay Dashboard Summary:

The Dashboard is the default landing page within the member portal. Summary information on
current check transactions and status will be displayed for accounts the user has been granted
access to. Active links are embedded within the box to permit users to navigate from the
dashboard landing page into the Check Positive Pay service module or directly to transactions in

the status selected.

End of Day Cut-Off Time: Monday 6:00 PM EST

Exceptions $32,122.55 €) Pending Approval $2,993.93 (2]
set to Pay $28,569.72 (32 ] Set to Return $3,802.03 (3]
System $28,560.72 e System 50.00 (0]
User $0.00 (0] User $2,093.93 (2]
FI $0.00 (0] FI $900.00 ©

The content displayed in the Check Positive Pay summary box includes the following:

» End of Day Cut-Off Time: Displayed in the second bar, the time of day indicates when
transactions that require decisions will no longer be eligible for user decisions.

» Exceptions: Clicking on the dollar amount hyperlink on the Exceptions line will direct the user
to a filtered view of Transaction History that will display only exceptions that require a
decision.

» Pending Approval: If Dual Decision Approval has been enabled, the Pending Approval
hyperlink will appear in the Dashboard. Clicking on the dollar amount hyperlink on the
Pending Approval line will direct the user to the Check Transaction Approval screen,
where the user can approve or reject any transactions that are pending approval by the
user.

» Default Decision: System Pay or Return indicate transactions that will pay or return if no
action is taken due to the default status. Users pay or return indicate a user decision has

occurred.

Rev February 2024

Proprietary and Confidential Information



NWEFCU Positive Pay User Guide

Managing Issued Items

Members who are enrolled in Standard Check Positive Pay must maintain a list of issued items for the
Credit Union to compare presented items against to identify exceptions. To optimize the user experience,
it is highly recommended that members enter, or load issued items prior to disbursing paper checks to
payees. Failure to do so could result in denial of payments if the check is presented at the teller line for

deposit or to be cashed.
Issue Template

Issue Templates provide an easy way to load issue items into Check Positive Pay using files that can be
generated out of most accounting systems. The issue template format will be configured to match the
format of the member generated file. This provides organizations with a variety of flexible options for
providing a list of checks that have been issued. Once a template has been set up, it can be selected

when loading a file to Check Positive Pay to be used in the matching process.

Supported Issue File Types

v" Comma Separated (.csv)
Fixed Width (.txt)
Excel Workbook (.xIsx)
Excel 97-2003 Workbook (.xIs)
Pipe Separated (.csv)
Semi-colon Separated (.csv)
Tab Separated (.txt)

LI NN NN

1. To create a template, select Issue Templates from within the Manage menu group.

£ Manage « s - J =
[ Issue Templates ]‘—
Welcome

2. Click the Create New Template button.
3. Matching the format of the template to the check file that you generate, enter the following:
a. Template Name
b. File Type
c. Template Status
i. Template status can be set to Active or Inactive. Active templates are used for

loading issue files; inactive templates cannot be used for issue file loading.

Rev February 2024
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i. Depending on the software, some files have header (beginning) rows or footer
(ending) rows containing data not required by Check Positive Pay. These rows
will not be analyzed.

e. Multi-Line Payee Name Separator (if applicable)

Create New Template

Template Name File Type’ Template Status
Fixed Width L Active v
Number of Header Rows Mumber of Footer Rows’ Template Level’

Client w

Multi-Line Payee Name Separator:

4. The Check Serial # and Amount fields are always required. User must specify whether the

amount data in the imported file will or will not contain decimal points.

5. If the Member checks the Status box additional fields displays as shown below. If the Member’s
accounting system exports issue items with an Issued or Voided status, no additional action is
required.

6. If the Status box is checked for a template, and this information is not provided in the issue file
loaded, the system will give each record an ISSUED status.

7. If the account box is selected, the user can import one file that contains issue items for multiple
accounts. If the issuance date box is NOT checked, Check Positive Pay will default the issue date
to date the file was loaded.

Rev February 2024
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Add Input Field’ Start Pasition® End Position’ Field Format
Serial Number
Amou 8 Fractional Dollars (12.34
'Whole numbers of cents (1234)
Status reTLED for ISSUED
CTAPDED for STOPPED
i for VOIDED
Account Number
ssuance Date
Payee Mame
B Routing Number’
rsor over this labe

m
s

8. Once all the information is completed click save. Check Positive Pay allows creating up to 6

additional issue fields within an issue template.

Rev February 2024

Proprietary and Confidential Information



NWEFCU Positive Pay User Guide

Issue File Load:
Check Positive Pay allows Member users to load issue files into the system for use in matching. It

accepts these files in a variety of formats, used in conjunction with file templates.

1. To upload a file of issued check information, click Issue File Load from within the Perform menu
group.

&M v # perform « AT

[ Issue File Load ]<—

2. Once the Issue File Load screen appears, select the Template drop-down to select from a list of
existing templates. If only one template is available for a member, the drop-down box selects that
template by default.

3. Select an Account from the drop-down.

Issue File Load

Template to Use With Issue File Account’

Excel Workbook 2 v - not selected - v Create Mew Template

- not selected -
FFF Escrow - xxxx4444

S Ten
w s fomplate FFF Expense - 3333

FFF Payroll - xxxx2222
Select account and template that matches issue file format| FFFriends - xomi111

4. Click the Browse button to select the appropriate file. Once the file is selected, it displays in the
upload interface.
5. The Status Bar displays the Current Status of the file.

a. A successful file upload will display a status of Complete.

Rev February 2024

Proprietary and Confidential Information



NWEFCU Positive Pay User Guide

o W \

< Back to Status WKP1 Issue 1028-001.xlsx

File Status

Queued Processed Approved / Rejected Comgleted Deleted

-~ Fat s

6. If errors are encountered during the initial processing of the issuance file, the Parse Errors display
appears, allowing the user to view the error detail within the file. Once all errors are corrected, the
red highlights are no longer visible, and the file can be reprocessed by clicking the Save and
Submit button.

Number Account Seral Number Amount Payee Name Status Issuance Date Deiete

(R $rnerin ‘ — Pk o 49 b pinpb

Manual Entry:

Members can manually enter the information of checks that have been issued. To manually enter an
issue item, the user must be granted the manual issue entry user privilege.

1. From the Perform menu group, click on Manual Issue Entry.

[ Manual Issue Entry J<—

Welcome

Please use the above menu

Rev February 2024
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2. When the Manual Issue Entry screen appears, select the appropriate account from the dropdown.

3. Enter the following:

a. Serial/Check Number
b. Amount

c. Payee Name (if applicable)

i. If there are multiple payees, an Enter (carriage return) must be used to input a

second, third or fourth payee on separate lines in the field for it to be
distinguished as different payees.
d. Status

e. lIssue Date

Manual Issue Entry

Account’

Auto populate next check number:
- not selected -

Row Serial Number Amount Payee Name® Status Issuance Date

ISSUED - 03/03/2021

€ Click any row to select that row for editing

Save

4. Once the required issued item information has been entered, click the Save button.

5. The Manual Issuance File Status detail appears.

< Back to Status

MANUAL_1617197309551

File Status

Queued Processed Approved Completed Deleted

File processing is complete. View list below to see items.

@ View items: 2 Items totaling $80,001.00 Load Date: 03/31/2021 09:28:29 EDT

Rows 1-2af 2.

Account Number Serial Number Amount Payee Name Status Issuance Date
Xoxxiii 40000 $40,000.00 Formula 1 AVAILABLE_FOR_MATCHING 03/31/2021
xaxxx1111 40001 $40.001.00 Lewis Hamilton AVAILABLE_FOR_MATCHING 03/31/2021

Delete

Rev February 2024
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Exception Processing

When a check cannot process and clear normally, the payment becomes an exception item requiring
special handling. If Payee Positive Pay is enabled, the check image is scored through payee name
comparison. When an item is marked as an exception, the Check Positive Pay system will follow the
default exception action configured in the account regarding whether to pay or return the presented item, if
no action is taken by the member. When an item is matched successfully and no exceptions are identified,

the presented item is paid.

To review exception items:
1. From member dashboard select dollar amount next to Exceptions
2. The transaction history will display exception items only.

3. Once the exception reason is reviewed, select the desired decision under change status.

Date Range

Transactlon HIStory EAugust 1, 2021 - August 31, 2021 -

Mass Pay & Issue

Y Filters >

Transaction ID Account Number Serial Number Credit Debit Current Status Dateli Change Status Exception
¥ 49125 X011 12274 $127.00  Pay-System 08-31-2021 &
» 49128 0001111 12274 $27.00  Pay-System 08-31-2021 [:]
> 49127 %0111 12273 $35.10  Pay-System 08-31-2021 [:]
> 49126 *0x11711 12272 $20.00 Pay-System 08-31-2021 -]
» 49125 XXXX1111 12271 $200.00  Pay-System 08-31-2021 {: ]

Transaction History: In the above example, the user has clicked on the dollar value of Exceptions

on the Dashboard and is directed to a view of exception transactions that require decision.

Rev February 2024
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Decisioning Transactions

Once exceptions have been reviewed members are able to make decisions on presented items. To

decision a transaction:

1. Return: Under “Change Status”, change the status by clicking on Return and select a return

reason.

2. Pay: Under “Change Status”, change the status to Pay.

Transaction History

Y Filters
Transaction ID Account Number
> 1264882 x0x4680
» 1264881 xxxx4680

Account Name: Evens

Pasitive Pay Typs: payea

Issuance Payee Name: Natalie North
Issuance Serial Number: 8268
Issuance Amount: $30.00

Issuance Date: 01/28/2024

Criginal Serial Number: 8268

Original Ameount: $30.00

v 1264880 WOAGED

Account Name: Evens

Positive Pay Type: payes

Issuance Payas Name: Markus Meltan
Issuance Serial Number: 8267
Issuance Amount: $260.00

Issuance Date: 01/28/2024

Original Serial Mumber: 8267

Criginal Amount: $300.00

Mass Pay & Issue Payee Review (5)

Serial Number

8269

Debit Current Status Dateli
$900.00  Return-FI 01/29/2024
530.00 Pay-System 01/29/2024

Payment Date; 01/28/2024

Payae Analysis: Pass

5300.00 Return-User 01/29/2024

Return Date: 01/25/2024 6:00 PM EST
Return Reason: Wrong Amount
Loaded Exception Reason: Amount Mismatch

Payee Analysis: Fail

=m -

Date Range
8 Jan 26, 2024 - Jan 29, 2024 ~

Change Status Exception

4

@ Ineligible

Adjust Motes {0}

Adjust Notes {0)

Proprietary and Confidential Information
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Review Payee

The Review Payee functionality has been introduced to allow users to visually inspect presented items to

ensure fraudulent transactions that may not have triggered any exceptions are identified.

1. If Payee Positive Pay is configured, the Review Payee feature may be available in
Transaction History. Review Payee allows users to easily view non-exception items for

transactions on accounts enrolled in Payee Positive Pay.

2. From within Transaction History, the Payee Review button appears at the top of the
screen with the total number of non-exception items available for review in

parentheses. Click the Payee Review button to proceed.

1
A ¢ Numbe Pech Numbe e et ent Stat Dateli

> 3 $ @ Return

3. The Payee Review screen appears. The Payee Review page displays all current day non-

exception transactions for all accounts to which the user has access.

4. Atfter the check is reviewed members can return or pay the item.

5. Once the return reason is saved, the user will be returned to the Review Payee screen, and
the Return button will be displayed as an Undo button. If the user determines that the
Return should be undone, clicking the Undo button will change the status back to Pay, and

the screen will revert the button to Return.

Rev February 2024
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Transaction Information

Transaction ID: 7740710
Account Number: Xxxx1115
Check Number: 7291
Amount: $65.55
Issuance Payee: Mike Mechanics
Transaction ID: 7740709
Account Number: xxxx1115
Check Number: 7290
Amount: $90.00
Issuance Payee: ups

Image

Jamnes €. Morrison
12343 AnyWhere Circle

Your City, State 12345 BiianH iakile

DATE
04 /07 /2023

Mike Mechanic

Sixty five and 55 cents

ISN: 102202195

00000450

James C, Muorrison
12343 AnyWhere Circle

oo City. Ste 12348 Non-Negotable

Change Status

Test Capture Only

CHECK ND

7291 63.55

AMOUNT

** Void ** Void ** Void "

S DeLacre

BedbdbdbaSe* 7293 #O00D000ESS S,

Test Capture Only

Ninety and No cents
of

ISN: 102202194

n0Li0000% 5,

BRLLALAIALGT72R0

I DATE CHECK NO | AMOUNT
0407 223 7200 S w00
Pay uUpPs
ToThe ® Return
Ordar

** Void ** Void ** Void **

S beloere

+000000R000+
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Item Lookup

Check Positive Pay provides members with the ability to look up all recorded data on individual

issued items with the Item Lookup feature.

1. Within the Check Positive Pay module, click View > ltem Lookup.
2. The Iltem Lookup page appears. Enter search criteria.

3. Click Apply to complete the item lookup. Once Search results for the item are displayed,

within this screen, the lifecycle of the issued item is displayed.

Item Lookup

Account” Serial Number

The Cne and Only - 01111 (ASBank Client 1 - ASBC1) v 11548

Account Number: x01111 Serial Number: 11548

Transaction Date: 04-15-2021 Original Serial Number: 11548

Payment Date: 04-15-2021 Original Amount: $27.00

Transaction ID: 43566 Issuance Payes Name: FedEx

Debit Amount: $27.00 Issuance Serial Number: 11548
Current Status: Pay-5ystem Issuance Amount: $180.00

Issuance Status: ISSUED

Transaction Date: 04-15-2021 Original Serial Number: 11548

Payment Date: 04-15-2021 Original Amount: $127.00
Transaction ID: 45567 Issuance Payee Name: FedEx
Debit Amount: $127.00 Issuance Serial Number: 11548
Current Status: Pay-5System Issuance Amount: $180.00

Issuance Status: ISSUED

Issuance Date: 04/15/2021 Update By: mflestwood1

Updated Date/Time; 04/15/2021 13:34:17 EDT Transaction Id: 45565

Load Date/Time: 04/15/2021 12:34:17 EDT Issue Type: IS5UED

View Check Image

Exception Reason: Amount Mismatch
Payee Match Score: Error analyzing payee name

Disposition Created: 04/15/2021 15:00:00 EDT

Exception Reason: Duplicate Presentment
Payee Match Score: Error analyzing payee name

Disposition Created: 04/15/2021 15:00:00 EDT

Payee Name: FedEx
Match Status: PAID
Amount: $180.00
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ACH Positive Pay

ACH Positive Pay Debits and ACH Positive Pay Credits are two separate ACH positive pay services

designed to empower account holders to prevent financial loss due to unauthorized incoming ACH debit

and credit transactions.

ACH Positive Pay Dashboard Summary

The Dashboard is the default landing page within the member portal. If ACH Positive Pay is enabled,
summary box(es) will be displayed. Summary information on current incoming ACH transactions and

status are displayed for accounts to which the user has been granted access.

ACH Positive Pay - Debits

End of Day Cut-Off Time: Monday 6:00 PM EST

Total ACH Debits $174,167.28 © Pending Approval $0.00 (o]
Set to Pay 360,828.88 [ 50 ] Set to Return 5113,328.40 [ 36 ]
Approved List Exceptions $110,899.06 [s9 ] Block List Returns $40,800.00 [ 15 ]

ACH Positive Pay - Credits

End of Day Cut-Off Time: Monday 6:00 PM EST

Total ACH Credits $110,764.66 [ 68 ] Pending Approval $0.00 [0 ]
Setto Pay $40,584.00 [ 24 ] Set to Return $70,180.66 o
Approved List Exceptions $70,068.00 [ 38 ] Block List Returns $27,896.66 [ 26 )

» End of Day Cut-Off Time: Displayed in the second bar, the day and time transaction decisions
are collected by the financial institution. Transactions will be ineligible for pay or return decisions
after that time. If a pay or return decision has not been made, the System Pay or System Return

default applies.

» Total ACH Debits / Total ACH Credits: This total represents the total dollar amount and number
of incoming ACH debit transactions or ACH credit transactions received by the financial institution

for the accounts the user has access to view.

» Approved List Exceptions: This represents the total dollar amount and number of incoming
ACH credit or debit transactions received from companies that are not on the member’s approved

list or have violated an approved list parameter.

» Pending Approval: If Dual Decision Approval is enabled, the Pending Approval hyperlink
appears in the Dashboard. Clicking on the dollar amount hyperlink on the Pending Approval line

directs the user to the Debit or Credit Transaction Approval Screen, where the user can approve
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or reject transactions pending approval by the user.
» Block List Returns: This represents the total dollar amount and number of incoming ACH credit

or debit transactions received from companies on the member’s blocked list and will be returned.
» Set to Pay/ Set to Return: System Pay or Return indicate transactions that will pay or return if

no action is taken due to the default status.

Notification Rules

Notification rules establish who should be alerted, how they should be alerted, and the conditions
prompting an alert. Notification rules can be set on an account-by-account basis, or all accounts can be
configured with the same notification rules. The two notification options are email and SMS text.

Setup Notification Rules

1. From the ACH Positive Pay Module, click Manage > Notification Rules

Welcon secus

2. The Manage Notification Rules page appears. The Selection screen is the first screen of the

Notification Rules page and displays a list of all accounts the user has access to.

m Contacts Conditions Confirm

Account Selection

Select Account(s) Account(s) Selected
FFFriends -x0xxx1111*
FFF Payroll - xxoxx2222 *
FFF Expense - xxxx3333 * -
FFF Escrow - Xxxx4444 *

*Accounts with default Notification Rules

=+ Next

3. Select the accounts to be configured and move them to the Selected Accounts box.
a. Note: Multiple accounts can be selected to make changes.
4. Click the Next button to proceed.
The Contacts screen appears. The Contact screen will allow entry of up to 6 email addresses
and up to 6 cell phone numbers if SMS text has been enabled by the financial institution.

6. To add an email address, click the Emails box to expand the view.
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Enter the contact iInformation to receive the ALERT

Cell Phone Text

7. The Conditions screen is the third screen of the Notification Rules page. On this page, the user
can define the criteria for when alerts should be sent. The alert criteria controls the alerting
process but does not control the transaction status designated at load time. The transaction
status is controlled by the default setting, approved and block list settings.

Selection Contacts FeeLUIELER Confirm

& | Notify for all ACH Debits

Select a condition to recaive the Alert

otify only when an ACH Debit s over

ar ACH Dehit m

gne or more of ¢ criteri

The ACH De

vds Created from

The ACH Debit was created from a payment over the Internet

The ACH Debit was cr

ed from a payr

Natify only when an ACH Debit Is recefved from a Company 1D not on the Approved List or does not meet the parameters on the Approved List

+ Back

8. Click Next to go to the Confirm page. Review all information entered, and if correct, click the

Save button. If changes are needed, click the Back button to navigate back to the appropriate
screen.
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Selection Contacts Conditions [Eellildn

Confirm Notification Rules

Account(s) Selected
00001111, 002222, 20003333, x00dddd

Cell Phone Text

Cell Phone 1: 5554443333 Cell Phone 4:

Cell Phone 2: 8182099402 Cell Phone 5:

Cell Phone 3: Cell Phone 6:
Emails

Address 1: mhart@fffriends.com Address 4:

Address 2: fjones@fffriends.com Address 5:

Address 3 Address &

Notification Condition

Condition: Notify for all ACH Debits

Save |

+ Back T

9. After Save is clicked, a success message appears.

Selection Contacts Conditions Kelslalilgsl

Notification Rules have been configured successfully
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Exception Processing

There are two ways to navigate to the Transaction History page. One option is to navigate directly to ACH

Positive Pay Transaction History from the Dashboard, by clicking any dollar amount displayed within the

Dashboard. Another option is to navigate within the ACH Positive Pay module, to the View menu and click

Transaction History

Welcom

Please use the above m

enu to select

il

1. The Transaction History page displays all current-day transactions for all accounts to which the

user has access.

4

S

Y Filters

Date

> 0772772023

> 072712023

> 07272023

> 07/2712023

Debit Transaction History

Compary

Fine Fefines Gr

Fine Felines Gr

Fine Felines Gr

Marshall Modeiin

ACCOUNT #

%oce3333

103333

003333

wom3333

Amount

$100.00

$100.00

£100.00

£100.00

~

Current Status

Pay - System

Pay - System

Pay - System

Pay - System

Date Hanges

i jui 27, 2023 -

>
Ma 'l.;g-_" Viclation c
;
2
@ Return... Q
:

2. Ifthe user has been granted the Change Status user privilege and the transaction is eligible for a

decision, a Pay or Return button appears for use. If the transaction is ineligible for a decision, the

button will display as Ineligible.

3. To change status to Pay - click the Pay button under the Manage column.

Pay - System

Pay - System

Return - User

Pay - System

L% > *
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4. A success message will appear temporarily in the Manage column, with an option to Add
to Approved List. If the user does not opt to Add to Approved list, the option is still
available under the expanded view of this debit item. The Current Status column will

update to “Pay-User.”

Date Company Account # Amount Current Status Manage

> 08/06/2020 Niveena's Natura XXXXT678 $60.00  Pay-System ® Return
> 08/06/2020 Marshall Modelin UXXNTB78 $1,042.00 Pay-System ® Return

> 08/06/2020 Leningrad Livery XXXXTB78 $86.20 Pay- User ® Return

5. If the Current Status on an issued item is set to Pay, the member can change the status to

Return by clicking Return button under the manage column.

Date Company Account # Amount Current Status Manage
¥ 0B/06/2020 Niveena's Natura XXxXxT678 $60.00 Return - User Debit will be returned
+ Add to Block List
» 08/06/2020 Marshall Madelin XAXXHTE78 $1.042.00 Pay- System

6. Once a user chooses to return a transaction, a Written Statement of Unauthorized Debit

pop-up screen will appear depending on the SEC code of the transactions.

7. The user will be prompted to select a reason for the return of the transaction by clicking in one

of the radio buttons by the appropriate return reason.

8. Once the reason has been selected, click Next to continue. Clicking Cancel will cancel the

process and the user will be returned to the Transaction History screen.

Written Statement of Unauthorized Debit

Never Authorized to Debit Account
Authorized ACH Debit Amount Incorrect
Debited Before Date Authorized

Debit Authorization was Revoked

3rd Party Did Not Send Funds to Payee

Improperly reinitiated *

(s =
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9. Depending on the return reason selected, the user may have an additional screen to provide
more information about the return reason, such as correcting the ACH Amount, or selecting the
date the debit was authorized, etc. Once this screen has been completed, click Next to continue.

10. The final screen within the pop-up window is the Written Statement. The content of the
Written Statement displays based on the valid return options for the disputed transaction.
The Written Statement must be completed for the transaction to be returned. If the Written

Statement is abandoned, the transaction status will remain unchanged.

11. The user must consent to the Written Statement of Unauthorized Debit by electronically
signing the consent statement. Once the signature has been captured, the “e-signature
needed” button will change to a Sign button. Note- a PDF copy of the Written Statement will

download by default. Once the screen is correct, click Sign to proceed with the return

process.
)
I consent to electronically signing this form &
Electronic Signature
& Download POF Copy < *
o |
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Approved List

The Approved List allows clients to identify companies that are allowed to credit or debit an account and

set parameters to control the credit activity.

1. Members can create an approved list to easily manage the daily ACH transactions. Within
the ACH Positive Pay Module, click Manage > Approved List.

& Mar age ~ s -~ M . =
Notification Rules
| Approved List H—
Welcon eedus
Please use the above menu to select an actior

2. The Approved List page displays. To create an entry for the Approved List, click the Create

button.

Company ID ¢ Company Name ©

Deiete Max Amount Frequency Start Date End Date Edn

3. The Add Company page will display. Complete all applicable fields in the top section of the

screen.

Approves Company

Compary Detas

Compary 1D Cormgarty Narme
Max Amaunt Freguency MO Freguency -
Start Date 110542020 Enst Date

Ardd Accounts-ta Appraved List

=~ Save ® Canged
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4. Choose from the list of available accounts to add to the Approved List. Once the entry is
completed, click Save to save it to the Approved List. A success message will appear.

5. To edit any entity on the Approved List, click the Edit hyperlink at the end of the appropriate
row to be taken to the Company’s screen.

6. To delete any entity on the Approved list, click the checkbox next to the appropriate row, and

click the Delete Selected button.

Approved Company Saved Successfully

+ Create
Approved List
Company ID ¢ Company Name &
Delete Maximum Amount Frequency Start Date End Date Edit
O ACME Acme Widget $20,000.00 06/18/2020 Edit
|5 TIONEST Tom Jones $50,000.00 MONTHLY 06/18/2020 Edit
@ Delete Selected @ Cancel

Add to Approved List from Transaction History

1. To add to the approved list from the Transaction History page, click the > arrow to expand the

entry of the ACH debit transaction.

Date Compary Account & Amaynt Curmeng Status Manage Viclation

v O7/26r5024 OLIVIA'S OMELETT widddd 5430000  Approved List Pay

2. Click the Add to Approved List button to add a company. The Add Company pop-up window will

appear.

3. Click the Save button to add to Approved List. Click Cancel to return to the Transaction History

without adding to the Approved List.
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Blocked List

The Block List allows members to identify companies that are not allowed to credit/debit an account or

accounts.

1. Member can create a Blocked List Within the ACH Positive Pay Module by clicking Manage >
Blocked List

3. The Blocked Company page will display. Complete all applicable fields in the top section
of the screen.
Blocked Company

Company Detail

Company ID Company Name

Start Date 04/07/2022 End Date

Add Accounts to Block List

MDC Main - xxxx5057

MDC Payroll - xeox5058

~ Save @ Cancel
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4. Choose from the list of available accounts to add to the Blocked List.

Add Accoonts to Biock List

5. Once the entry is completed, click Save to save it to the Blocked List. The new entry appears
on the Block List.

6. To edit any entity on the Block List, click the Edit hyperlink at the end of the appropriate row
to be taken to the Company’s screen.

7. To delete any entity on the Block list, click the checkbox next to the appropriate row, and

click the Delete Selected button.
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C.0.PS

ACH Credit Origination Positive Pay Service (C.O.P.S.) is designed to provide members (e.g. ACH
Originators) with protection against fraudulent ACH credit origination activities. By monitoring the
destination of ACH credit transfers, ACH Credit Origination Protection (C.O.P.S.) can provide maximum
security. Each outgoing ACH credit transaction is analyzed against an approved list of registered payment
recipients. If all transactions match the approved list, the ACH file will process as usual. If a transaction
does not match the approved list, an alert is sent to the Originator’s user via an out-of-band method, such
as an SMS text. Upon receipt of the alert, the user can access the system to view the suspect
transactions, and if fraudulent, reject the batch to stop an account takeover attempt and prevent financial
loss.

When an ACH Company ID is enrolled in C.O.P.S., the ACH Notify feature can be enabled.

ACH NOTIFY: Customer Notification

support@achalertinfo
To Liz Delaere

ACHNOTIFY

Co ID: A0D0O1

Total CR: 2 - $300.00

Total DR: 3 - $450.00

DeLaere B&T

(800) 123-4567

Contact before 04:00 PM US/EASTERN to cancel

Sincerely,
DeLaere B&T

Contact Us
Please do not reply to this email. If you have questions about your account. please call Customer Service at (800) 123-4567 or email us at support@achalert info

DeLaere B&T
1 Main St
Ooltewah, TN 37363

C.0.P.S. Dashboard Summary

The Dashboard is the default landing page within the member portal. If ACH Credit Origination
Protection (C.0.P.S.) is enabled, an ACH Credit Origination Protection (C.0.P.S.) summary box is
displayed. The Dashboard provides a quick reference summary of the current day’s file information.

ACH Cradit Girgination Protection |

End of Day Cut-Off Time: Thursday 6:00 PM EST
Total Credits $92 7000 353 |
Exceptions $35,100.00 [ xen |
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Manage Batches

If origination batches have been loaded that have suspect recipients (e.g., account number/routing
number combinations) in them, the batches require review and decisioning by the Originator.

Origination File

Upon an ACH Credit Origination Protection (C.O.P.S.) Pending ACH Batch alert being received by
Member Contact(s):
1. Within the ACH Credit Origination Protection (C.0.P.S.) module, click Manage > Batches.

Welcome

Plaace

& USE e aDOVE MENL 10 SeteCl an aCho

2. The Manage Batches page appears. Members can filter the date range of items shown.

Date Range

Manage Batches & Jan 25, 2024 - |an 26, 2024 ~
Y Filters >
1-8af 8.
Batch IDI: Client Co. Name # Exceptions $ Exceptions #Credits  $ Credits Current Status Manage
> 1163166 2022.2 Liz Co Empire Excavator 0 $0.00 36 $27.000.00 RELEASED ® Inel gible
2 1163165 20222 Liz Co Del Aire Develop 54 $10.800.00 54 $10,800.00 PENDING Details
> 1163164 2022.2 Liz Co Cartwright Car S 60 $6.000.00 a0 $6,000.00 PENDING Details
> 1163162 2022.2 Liz Co Ashland Armament " $1,500.00 b & | $1,500.00 PENDING Details
> Batch ID: System assigned number.
> Client: Client registered in ACH Credit Origination Protection (C.0O.P.S.)
»  Co. Name: Originator Company Name from the batch header record of the ACH Issuance file.
> # Exceptions: Total number of exception transactions in the batch.
> $ Exceptions: Total dollar amount of exception transactions in the batch.
> # Credits: Total number of credit transactions in the batch.
»  $ Credits: Total dollar number of credit transactions in the batch.
> Current Status: See below for a list of statuses and the corresponding meaning.
> Manage:

1. Details: Actions can be taken on this batch.

2. Ineligible: No actions can be performed on this batch.
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3. To narrow the search results, click Filters a window containing additional search
criteria will appear.

Manage Batches

T FAlters

Companies

Drate Range

Batch Status

4. Click “Apply” to narrow your search results. Use the navigation buttons at the top of the

search results to review all results.

Batch Status

See the example of what each batch status means.

BEING MANAGED

Once a user has clicked “Manage.” This prevents another user from
managing the batch. To allow other users to manage the batch, the user that
clicked Manage needs to click Cancel on the ACH Origination — Pending
Manage Batches page.

APPROVED
A user has clicked “Approve Batch” and exception items have been
registered as either One Time or To List.

REJECTED A user has clicked “Reject Batch” and none of the exception items
have been registered.

RELEASED The batch has been released to an outbound file.

DEBITS ONLY
The batch has only debit transactions and no credit
transactions.

PROCESSING The file is in the process of being loaded.

PENDING The batch has exception items to be approved or rejected

ALL REGISTERED

The file loaded with all recipients registered

NON-SUBSCRIBE R

The Company ID is not registered.

UNREGISTERED EXIST

The batch has some transactions to unregistered recipients.
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Approve Batch

1. From within the Manage Batches page, click on the Details button.
a. Note: When the user clicks on the Details button to view a batch, the Batch Status will
change from PENDING to BEING MANAGED. This prevents another User from
managing the batch at the same time. To allow other users to manage the batch, the user

that clicked Details to Manage needs to click Cancel to return to the Manage Batches

Jate Range
Manage Batches B8 Jan 25, 2024 - Jan 26, 2024 -
Y Filters >
BatchIDE  Client Co. Name #Exceptions  §Exceptions  #Credits  § Credits entStatus  Manage
> P & Deve $ $ t 1
> A $1 $ EASE
window.

2. The Manage Exceptions window will display.

3. Toadd transaction details to the Approved List:
a. Selectthe Add All checkbox to add all transactions to the Approved List.
b. Select the Add to Approved List next to each transaction to add individual

transactions to the Approved List.

Manage Exceptions

BatchID Client Co. Name # Exceptions $ Exceptions # Credits  $ Credits Current Status
Ashland Armament 4 $1,500.00 - $ 550
Individual ID Name Routing # Account No Credit Amount Add All
EMPID 123456789 Brandon Harrison 22172441 oo0222 $15 2 Add To Approved List
EMPID 123456789 Avery Gamble 322172441 00xx0222 $100.00 2 Add To Approved List
EMPID 123456789 Alden Allisor 322172441 00222 $150.00 £ Add To Approved List
4 H 217244 222 $150.00 4 Add To Approved List

Enter Authorization Code:
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4. Once any transactions are selected to add to the Approved List, click the Approve button. The
user will be prompted to enter the Authorization Code.

5. Click Save.

a. Note: Success Message will display.

Batch has been APPROVED Successfully!

Reject Batch

1. From within the Manage Batches page, click on the Details button.
a. Note: When the user clicks on the Details button to view a batch, the Batch Status will
change from PENDING to BEING MANAGED. This prevents another Fl User or Client
User from managing the batch at the same time. To allow other users to manage the
batch, the user that clicked Details to Manage needs to click Cancel to return to the
Manage Batches window.

2. The Manage Exceptions window will display.

3. Click the Reject button. The user will be prompted to enter the Authorization Code.

Manage Exceptions

BatchID  Client Co. Name # Exceptions $ Exceptions # Credits $ Credits Current Status
4 $1.500.0 - $ 55 ENDING
Individual ID Name Routing # Account No Credit Amount Add All
123456789 8randon Harrisor 22172441 0222 $15 AddToApprovchn‘,(
12345678 Avery Gamble 22172441 $1 £ Add To Approved List

Alden Allis 2217244 & Add To Approved List

322172441 oox0222 $150.00 4 Add To Approved List

Enter Authorization Code:
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6. Click Save.

a. Note: Success Message will display.

Batches were Rejected successfully.

REMOVE FROM APPROVED LIST

To remove recipients (e.g. payees or Receivers) from the Approved List:

1. Within the ACH Credit Origination Protection (C.O.P.S.) module, click Manage > Approved List.

Welcome (oas e

2. The Approved List page appears.

Approved Recipients for 2022.2 Liz Co
Clanl Individual ID Individual Name Routing # Account # Company Name Category ID
EMPID 123456789 Joey Oliver 031000095 001442 Empire Excavator
EMPID 123456788 Cohen Jones 091202231 XXXX2455 Empire Excavator
EMPID 123456789 Chaz Sanders 091208879 XXXX2559 Empire Excavator
O EMPID 123456789 Kaleb Able 091208879 XXXX2450 Empire Excavator
O EMPID 123456789 Alex Cooper 091211471 XXXX3546 Empire Excavator
O EMPID 123456789 James Brown 091211905 XXxXX1775 Empire Excavatar

3. All Approved Recipients will appear by default. The Approved List can be filtered by
selecting a specific Company, Individual Identifier or Individual Name from the drop-down
menus provided.
Select the checkbox(es) to the left of the Individual ID for each Approved Recipient to be removed,
Click Delete.

a. Note: Success message will display.

Approved Recipients removed successiully.
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Appendix A: Reports

Members can generate and view a variety of reports from the Dashboard, Check Positive Pay, and ACH
Positive Pay modules that will help to track activity. To view reports, choose the appropriate module and
select the Report menu option. Once a specific type of report is selected, the appropriate filters can be

applied prior to searching.

Welcome [ :c"*"a-‘-v';“m:;r*'f H_

List of Reports by Module

Dashboard Reports:

» Audit Report: The audit report tracks information regarding users who accessed the service.
» Notification Delivery Report: This report provides information related to the deliveries status of

the alerts generated by the service modules used.

Check Positive Pay Reports:

> lIssue Item: Issue Item report allows members to locate checks based on the status; member can

individually locate check with Outstanding, Paid, Returned, Stops or Void checks from this report.

ACH Positive Pay Reports:

» Approved List: The Approved List report makes it easy for users to identify the companies set
up on the approved list for a specific account.

» Block List: The Block List report makes it easy for users to identify all the companies set up on
the block list for a specific account.

» Notification Rules Report: The Notification Rules report allows authorized Member users to

view the notification conditions set for each account enrolled in the service.
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Appendix B: Exception Codes

Exceptions occur when a check or ACH doesn’t match with the approved items or issued items. Members
can review the exception items and make decisions on whether to pay or return an item before the daily
cutoff time. Below is an example of exception item codes and the corresponding meaning.

ICON EXCEPTION CODE EXCEPTION REASON

Check presented where no issue item is found to match
Issuance Not Found against.

jo

Check presented with a serial number previously presented.
Issuance Already Used

Check presented with a serial number of an issue item
Issuance Voided marked with a void status

Check presented with a serial number of an issue item
Issuance Stopped marked with a stop status.

© 0 | Q

Check presented where the amount of the check
$ Issuance Amount presented differs from the issue amount.
Mismatch

Transaction amount is over the limit

2 Amount Over Limit
Check presented with a date before the issuance date on the
®© Early Presentment issued item
Check presented with a date exceeding the specified
= Issuance Stale Dated number of stale days for the account.
Check presented where payee name differs from issue
9 Issuance Payee Mismatch | payee name

. o This exception reason is only used if the reason that
(> Exception Reason Missing | is coming into Check Positive Pay has not been
received yet
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Appendix C: End of Day Cutoff Schedule

Pay/Return Decision Deadline: You must complete all Pay/Return Decisions through the online banking
portal by the following times:

Check Positive Pay 11:30 AM (Eastern Standard Time) on the
same business day that you received the
exception details.

ACH Positive Pay 2:30 PM (Eastern Standard Time) on the

same business day that you received the

exception details.

Credit Origination Protection. Positive Pay — 4:00 PM (Eastern Standard

Time) on the same business day that you

received the exception details.

Note: Any check or ACH items that you have not made a Pay/Return Decision on by the specified cutoff
will follow Default Decision established. We shall not be required to verify check or ACH items on the

exception details against previously cleared or posted items.
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